F9 Installation Guide for Pervasive PSQL v11 Server
Installing and Configuring Pervasive Database (Server Edition)
F9 Installation Guide for Pervasive v11 (Server Edition)

Contents
Introduction ........................................................................................................................... 4
Pervasive Products ................................................................................................................ 4
Complete vs. Custom Install ............................................................................................... 5
Common Review Questions ............................................................................................... 5
Installing Pervasive PSQL Server ....................................................................................... 9
  Before You Install: .............................................................................................................. 9
  Installing the Server ......................................................................................................... 10
Installing Pervasive PSQL Clients ..................................................................................... 13
Installing Pervasive PSQL Workgroup .............................................................................. 15
  Before You Install: .............................................................................................................. 15
  Installing Workgroup: ...................................................................................................... 15
After Installing Pervasive .................................................................................................... 20
  Common Questions: ........................................................................................................... 20
  Uninstalling Pervasive: .................................................................................................... 22
Configuring the Workgroup Engine .................................................................................. 24
  Overview: .......................................................................................................................... 24
  Setting Up a Small Client/Server Configuration: .............................................................. 25
  Setting Up a Peer-to-Peer Configuration: ......................................................................... 27
Configuring Engine Network Communications .................................................................. 29
  Setting Up TCP/IP Support: ............................................................................................. 29
  Setting Up SPX Support: ................................................................................................... 30
  Setting Up NetBIOS Support (Workgroup only): ............................................................... 31
Avoiding Unavailable Protocols: ..................................................................................... 33
## Configuring Network Communications for Clients

- Network Path Formats Supported by Requesters: ................................................................. 34
- Network Path Formats Supported by Requesters: ................................................................. 34

## Application Configuration Scenarios

- Terminal Services: .................................................................................................................. 36
- Active Directory Service: ......................................................................................................... 37
- Pervasive Administrative Authority: ...................................................................................... 38
- Active Directory Tasks: ............................................................................................................. 39
- Concurrent Local and Remote Applications: .......................................................................... 44
- Using the Server and Workgroup Engines Concurrently: ...................................................... 46
- Accessing Data on Other Computers: .................................................................................... 47

## Troubleshooting after Installation

- Troubleshooting Tools: ........................................................................................................... 48
- Troubleshooting Strategies: ..................................................................................................... 48
- Configuration for Special Installation Situations: ................................................................. 49
- Diagnosing Problems with Pervasive System Analyzer (PSA): ............................................ 51
- Verifying Database Engine is Running: .................................................................................. 51
- Obtaining File, Client, and Engine Version Number: .............................................................. 54

## Troubleshooting Common Pervasive PSQL Issues

- Engine and Client Version Conflicts ..................................................................................... 58
- Reference: ............................................................................................................................... 63
- Server vs. Workgroup Features ............................................................................................ 63
- Pervasive PSQL Base Components ....................................................................................... 64
Introduction

This guide represents the requirements to install and configure Pervasive v11 specifically for F9 Professional. F9 is Copyright © 2011 Infor. All rights reserved. www.infor.com

Its purpose is to act as a reference as well as a training guide for F9 Technical Support, Services, and Partners.

This document includes references and portions from the Getting_Started PDF by © Copyright 2011 Pervasive Inc., all rights reserved.

Pervasive Products

F9 Professional requires Pervasive to be installed as its database to manage integrations to accounting systems as well as for reporting in Excel.

There are 2 options for installing Pervasive depending on requirements for number of users and location of F9’s databases:

**Pervasive PSQL Workgroup**
- 1-5 Users
- Single-User or Small Network
- 32-bit
- Databases on Network or Local

**Pervasive PSQL Server**
- 6+ Users
- Network
- 32-bit or 64-bit Server (OS dependant)
- 32-bit Clients (Required for F9)
- Databases on Network
- Cacheing Performance
- Scalable to 1000’s of Users
Complete vs. Custom Install

Pervasive offers both Complete and Custom installation options and for the majority of F9 customers, selecting Complete will be sufficient.

**Complete**
- Recommended 1-10 Users
- Configures Default Features

**Custom**
- 10+ Users
- Performance Settings
  - Increase Cache Allocation on Server
  - Enable/Disable Cache on Clients

Common Review Questions

Where do I install the Pervasive PSQL Server?
- On the same computer where the database files are located

What about the Server’s client software?
- On every computer that is expected to access the database

Where do I install the Pervasive PSQL Workgroup?
- On the same computer where the database files are located
- On other computers to access the data over the network

What about the Workgroup’s Client software?
- Is installed with every engine.
- If you access remote files through another Workgroup engine, the Client software is already installed, so you do not need to install the Client separately.
How do I install Pervasive PSQL in a Microsoft Cluster Services environment?

- Refer to Failover Cluster Support in the Advanced Operations Guide by Pervasive Inc.

How do I install Pervasive PSQL in a Microsoft Terminal Services or Citrix MetaFrame environment?

- You must be logged on to the console of the server as a user with system administrator rights to install.
- Can either be the physical console on the server or a remote console session.

**Caution** If you are installing the Workgroup or Client Engine on a Terminal Services Environment, the engine is installed by default to run as a service.

- Only one instance of the database engine may run on any terminal server platform.
- You cannot run separate copies of the database engine within two or more terminal sessions.
- Refer to the Pervasive PSQL Web site for the list of Terminal Server Environments supported by Pervasive PSQL Server, Workgroup and Client (http://www.pervasivedb.com).

**Note** If a user starts the Workgroup Engine or Cache Engine in a Terminal Services session or in a multi-user environment where fast-user switching is used, other users on the system cannot access that engine nor can they start their own copy of the engine.

Status code 3032 results if a second user attempts to access another user's engine through the transactional interface.

If it is desirable to have multiple local users accessing a local engine, install the Workgroup or Cache Engine as a service.

How do I install my Pervasive PSQL database engine in a Microsoft Active Directory environment?

- Requires no special steps.
Follow the installation steps as described or the more detailed *Getting Started* manual by Pervasive Inc.

You may install on a domain controller if you choose. Be aware, however, that activity on the domain controller may affect the performance of the database engine. For this reason, you may prefer to install Pervasive PSQL on a server that is not a domain controller.

**Where do I install my Pervasive PSQL Clients accessing Web applications?**

For Web applications, the Client must be installed on the same computer as the Web server. Multiple Web server platforms require a client on each platform.

**Does it matter if I use Pervasive PSQL Clients that are of a different version than that of the database engine?**

Pervasive recommends you use Clients of the *same* version as the database engine. Clients that are a newer version than the database engine may or may not function correctly. Therefore, Pervasive recommends that you avoid the use of newer version Clients with an older engine.

**Does it matter where I download the Pervasive PSQL v11 SP1 install file?**

Yes, it does matter.

If installing a downloaded version of Pervasive PSQL, do not place the install file in a location that is listed in the PATH environment variables, as this can cause issues with file copying during install.

Place the setup files in a location such as the Windows TEMP directory.

**My system runs 24/7, is any time better than another for installing or upgrading to Pervasive PSQL v11 SP1?**

Should be performed during a period when all users are logged off the system and all data files are closed.

Be sure to back up any important files on the target hard drive, including data files, before you begin the installation.

If an upgrade, keep the installation media and instructions from the old installation, in the unlikely event that you need to fall back to the previous version of the product.

**How can I restrict users running in Terminal Services from changing Pervasive PSQL configuration settings, creating DSNs, and using the Monitor utility?**
Pervasive PSQL clients running within Terminal Services client sessions can perform Pervasive PSQL administrative functions by default. For example, a user with such a client can change configuration settings for Pervasive PSQL, create DSNs, and use the Monitor utility.

In prior releases, the ability to perform administrative functions was prohibited from the client.

To restrict this capability, a system administrator should follow these steps:
1. From PCC, open the properties for the MicroKernel Router under Local Client.
2. On the Properties dialog, check: Restrict Administrative Functions from a WTS Client.
3. Click OK, exit PCC, start again for the setting to take effect.

Are there any special settings I need to make for my configuration that aren't listed here?

Yes, there are some default settings in Pervasive PSQL that need to be adjusted if your configuration includes certain qualities. For example, the default settings need adjustment if you have:
- Multiple network interfaces
- Database Files that must not include Embedded Spaces
- Microsoft Active Directory Service
- A Network that is subject to outages

Please review Configuration for Special Installation Situations for these or other relevant issues, especially if you encounter problems after installation.

How do I Convert My Files from Previous Pervasive Products?

Not required but convert to take advantage of new v11 features.

With F9's ODBC Datapump and ASCII integrations:
- If your database(s) can be replaced to re-populate all Years, this may be the simplest option
- Alternatively F9 Professional Services can setup a scripting process to convert the Btrieve database(s) over to Pervasive v11.

Users of previous Btrieve versions can also use the Rebuild utility; refer to the Advanced Operations Guide by Pervasive Inc.

What User License Was Installed with Pervasive PSQL?

A trial license is installed if you leave the license number blank during installation.

After installation, you can use the License Administrator utility to view your installed licenses.

See the Pervasive PSQL User's Guide for more information.
Installing Pervasive PSQL Server

Before You Install:

Platform Notes

- You must have full administrator-level rights on the machine where you will install Pervasive PSQL.

Installing the Engine on Terminal Server

You must be logged on to the console of the server as a user with system administrator rights to install. This can either be the physical console on the server or a remote console session.

Install Pervasive PSQL as you normally would using the steps discussed in this guide. The operating system automatically handles the changing of terminal server modes.

Running the Engine on Terminal Server

Only one instance of the database engine may run on any terminal server platform. You cannot run separate copies of the database engine within two or more terminal sessions.

Installation Tips

- When installing Pervasive PSQL v11 SP1 for the first time on a system, Setup checks if all of the needed system files meet the minimum requirements. In some cases, these files are locked by the operating system and a reboot is required before Setup can continue.

Caution You must reboot your system if you encounter the reboot message. If you do not reboot your system, Setup encounters failures during engine and utilities configuration.

- If you have any trouble with the following installation, see Troubleshooting After Installation.
Installing the Server

You must install the Pervasive PSQL Server at the server itself; you cannot install it remotely from a client machine.

**Note** If the installation fails for any reason, the installation log file can be found in the Windows %Temp% directory.

The following steps explain how to install Pervasive PSQL Server using the default interactive installation.

➢ **To install Pervasive PSQL Server for Windows**


2. Launch **PSQL-Server-11.10-win.x86.exe** (32-bit) or **PSQL-Server-11.10-win.x64.exe** (64-bit) from the location where the exe file was saved. You will be prompted for the folder to unzip all installation files and the default is Windows temp.

The installation program begins its initial preparation.

3. If prompted, close or uninstall any running applications that may interfere with the Pervasive PSQL installation.

**Note** If you wish to leave one or more programs running that may interfere, you must click **Ignore** to continue. Unpredictable results may occur during the Pervasive PSQL installation if you ignore programs that may interfere.

4. At the **Welcome** screen, click **Next**.

5. On the **License Agreement** page, read and accept the Software License Agreement, then click **Next**.

6. Select the setup type: **Complete** (default) or **Custom**.

The **Complete** setup (recommended for most users) installs all the Pervasive PSQL v11 SP1 components using the default options and locations.

- If you choose a **Complete** install, click **Next** and continue with step 10.

The **Custom** setup (recommended for advanced users) allows you to specify the installation location, select the optional features and associated subfeatures to install, and determine the space requirements for the components.
If you choose **Custom**, click **Next** and continue with the following steps.

7. To specify different installation locations, click **Change** for any of the folders listed, then enter or browse for a different folder. Click **OK** to accept the location.

8. Click **Next** to continue.

9. Select the optional features and associated subfeatures you want to exclude from the installation and click **Next**. All of the Pervasive PSQL optional features and subfeatures, except for Xtreme I/O, are selected for installation by default.

F9 does not require any of the optional components to be installed in order to function properly.

10. Click **Install** to begin installation.

11. A dialog displays when the installation wizard completes. The product has been installed with a trial key that expires at the end of its trial period.

You have two choices at this point: continue and authorize the product with a permanent key, or end the installation (and later authorize the product with a permanent key).

   - If you choose to continue and authorize the product, an Internet connection is required. Click **Next** and continue with step 12. (If you have no Internet connection, click **Next** then click **Finish**. See Alternative Authorization Tasks in *Pervasive PSQL User's Guide*.)

   - If you choose to end the installation at this point, click **Next** then click **Finish**. (You may run the License Administrator utility at a later time to apply a key. See License Administration in *Pervasive PSQL User's Guide*.)

12. Enter your license key and click the button to apply the key.

   (If you decide not to authorize the product at this point, click **Finish**. You may run the License Administrator utility at a later time to apply a key. See License Administration in *Pervasive PSQL User's Guide*.)

13. A message box displays with the status of the authorization action. Perform one of the following actions depending on the status:

   - If the authorization status message is “**key is authorized,**” click **OK**, then click **Finish** to complete the installation.
If the authorization status message reports an error or warning, click **OK**, and repeat step 12, ensuring that you enter a valid license key.

14. Register your product (recommended) as explained on the Registration page that displays, then close the Registration page.

If you are prompted to reboot your system, please do so in order to ensure proper operation of your Pervasive PSQL v11 SP1 product.

**Note** The installation program modifies some of the environment variables. On Windows platforms, environment variables are stored in the Control Panel under System information.
Installing Pervasive PSQL Clients

You must install the Pervasive PSQL Client for Windows at the client machine itself; you cannot install it remotely from a server machine.

The Pervasive PSQL Client is installed by default with the Server and Workgroup engines; a separate installation is no longer necessary.

**Note** If the installation fails for any reason, the installation log file can be found in the Windows %Temp% directory.

The following steps explain how to install Pervasive PSQL Client from its media using the default interactive installation.

**To install Pervasive PSQL Client for Windows**


2. Launch **PSQL-Server-11.10-win.x86.exe** (32-bit) or **PSQL-Server-11.10-win.x64.exe** (64-bit) from the location where the exe file was saved. You will be prompted for the folder to unzip all installation files and the default is Windows temp.

3. Click **Client** installation for the 32-bit architecture—the only version supported by F9.

   The installation program begins its initial preparation.

4. If prompted, close or uninstall any running applications that may interfere with the Pervasive PSQL installation.

   **Note** If you wish to leave one or more programs running that may interfere, you must click **Ignore** to continue. Unpredictable results may occur during the Pervasive PSQL installation if you ignore programs that may interfere.

5. At the **Welcome** screen, click **Next**.

6. For the 32-bit Client only, select the engine installation mode (): **Run as an Application** (default) or **Run as a Service**.

   **Caution** Running the engine as a service requires the **Log On as Service** privilege. If you select to run the engine as a service under a user account other than the default Local System
account, you will need to modify the Log On Properties for the Service using the Windows Control Panel.

7. On the License Agreement page, read and accept the Software License Agreement, and then click Next.

8. Select the setup type: Complete (default) or Custom.

The Complete setup (recommended for most users) installs all the Pervasive PSQL v11 SP1 components using the default options and locations.

   • If you choose a Complete install, click Next and continue with step 11.

The Custom setup (recommended for advanced users) allows you to specify the installation location. For the 32-bit client only, you may also select the components and associated subfeatures to install, and determine the space requirements for the components.

   • If you choose Custom, continue with the additional steps.

9. To specify different installation locations, click Change for any of the folders listed, click Change for any of the folders listed, then enter or browse for a different folder. Click OK to accept the location.

10. Click Next to continue.

11. For the 32-bit client only, select the components and associated subfeatures you want to exclude from the installation and click Next. All of the Pervasive PSQL components and subfeatures are selected for installation by default.

   Note The Client 64-bit installation does not include the utilities, documentation, or SDK components listed above. To install them, you need to install both the Client 64-bit and Client 32-bit products.

12. Click Install to begin installation.

13. Once the installation is complete, the final dialog of the Installation Wizard displays. Click Finish. If you are prompted to reboot your system, please do so to ensure proper operation of your Pervasive PSQL v11 SP1 product.

   Note The installation program modifies some of the environment variables. On Windows platforms, environment variables are stored in the Control Panel under System information.
Installing Pervasive PSQL Workgroup

Before You Install:

Installation Tips

- When installing Pervasive PSQL v11 for the first time on a system, Setup will check if all of the needed system files meet the minimum requirements. In some cases, these files are locked by the operating system and a reboot is required before Setup can continue. Click Yes to reboot the system. Setup is then automatically restarted.

- It is strongly recommended that you reboot your system if you encounter this message. If you do not reboot your system, Setup will encounter failures during engine and utilities configuration.

Installing Workgroup:

Note If the installation fails for any reason, the installation log file can be found in the Windows %Temp% directory.

The following steps explain how to install Pervasive PSQL Workgroup from its media using the default interactive installation.

To install Pervasive PSQL Workgroup for Windows


2. Launch PSQL-Workgroup-11.10-win.x86.exe from the location where the exe file was saved. You will be prompted for the folder to unzip all installation files and the default is Windows temp.

   The installation selection dialog displays.

3. Click Workgroup installation.

   The installation program begins its initial preparation.
4. If prompted, close or uninstall any running applications that may interfere with the Pervasive PSQL installation.

**Note** If you wish to leave one or more programs running that may interfere, you must click Ignore to continue. Unpredictable results may occur during the Pervasive PSQL installation if you ignore programs that may interfere.

4. At the **Welcome** screen, click **Next**.

5. On the **License Agreement** page, read and accept the Software License Agreement, and then click **Next**.

6. Select the Workgroup Engine installation mode: **Run as an Application** (default) or **Run as a Service**.

   ![Figure 2 Engine Installation Mode Dialog Box](image)

   **Caution** Running the engine as a service requires the **Log On as Service** privilege. If you select to run the engine as a service under a user account other than the default Local System account, you will need to modify the Log On Properties for the Service using the Windows Control Panel.

7. Select the setup type: **Complete** (default) or **Custom**.

   The **Complete** setup (recommended for most users) installs all the Pervasive PSQL v11 SP1 components using the default options and locations.
   - If you choose a **Complete** install, click **Next** and continue with step 11.

   The **Custom** setup (recommended for advanced users) allows you to specify the installation location, select the components and associated subfeatures to install, and determine the space requirements for the components.
   - If you choose **Custom**, click **Next** and continue with the following steps.
8. To specify different installation locations, click **Change** for any of the folders listed, then enter or browse for a different folder. Click **OK** to accept the location.

9. Click **Next** to continue.

10. Select the components and associated subfeatures you want to exclude from the installation and click **Next**. All of the Pervasive PSQL components and subfeatures are selected for installation by default.

11. Click **Install** to begin installation.

12. A dialog displays when the installation wizard completes. The product has been installed with a trial key that expires at the end of its trial period.

You have two choices at this point: continue and authorize the product with a permanent key, or end the installation (and later authorize the product with a permanent key).

   - If you choose to continue and authorize the product, an Internet connection is required. Click **Next** and continue with step 13. (If you have no Internet connection, click **Next** then click **Finish**. See Alternative Authorization Tasks in Pervasive PSQL User's Guide.)

   - If you choose to end the installation at this point, click **Next** then click **Finish**. (You may run the License Administrator utility at a later time to authorize a key. See License Administration in Pervasive PSQL User's Guide.) See also Authorization of Workgroup Key on Vista and Windows 7.

13. Enter your license key and click the button to apply the key.

   (If you decide not to authorize the product at this point, click **Finish**. You may run the License Administrator utility at a later time to authorize a key. See License Administration in Pervasive PSQL User's Guide.)

14. A message box displays with the status of the authorization action. Perform one of the following actions depending on the status:

   - If the authorization status message is **“key is authorized,”** click **OK**, then click **Finish** to complete the installation.

   - If the authorization status message reports an error or warning, click **OK**, and repeat step 13, ensuring that you enter a valid license key.

15. Register your product (recommended) as explained on the Registration page that displays, then close the Registration page.
If you are prompted to reboot your system, please do so in order to ensure proper operation of your Pervasive PSQL v11 SP1 product.

**Note** The installation program modifies some of the environment variables. On Windows platforms, environment variables are stored in the Control Panel under System information.
Authorization of Workgroup Key on Vista and Windows 7

You can encounter difficulty authorizing a permanent key for Pervasive PSQL Workgroup on Windows Vista or Windows 7 if the following conditions are all true:

- Pervasive PSQL Workgroup was installed as an application.
- The Workgroup database engine is running without administrative privileges. Note that, by default, applications run with privileges of a standard user unless the privileges are elevated. That is, even if you are a member of the administrator’s group and you start the Workgroup database engine without using Run as Administrator to elevate privileges, the engine runs with privileges of a standard user.
- A permanent key for Pervasive PSQL Workgroup was not supplied during the installation process. That is, you chose to authorize the permanent key after installation by using a licensing utility.

Complete the following steps to ensure a permanent key is correctly authorized:

1. If the Pervasive PSQL Workgroup application is running, close the application (stop the database engine by right-clicking on the engine tray icon then clicking stop).

2. From File Explorer, locate the file w3dbsmgr.exe. Look for the file under <install_drive>\Program Files\Pervasive Software\PSQL\bin.

3. Right-click w3dbsmgr.exe then click Run as Administrator. You must have administrative rights or know the password and name of a user with administrative rights. You need to elevate the privileges of the database engine before authorizing a key with a licensing utility.

4. Start License Administrator from the Pervasive group in the Start menu (or use the command line interface licensing utility if you prefer).

5. Type or paste the permanent key for Pervasive PSQL Workgroup in the Key field, then click the button to apply the key.

6. Optionally, stop the database engine and re-start it without elevated privileges.

Note that elevating the privileges for a license administrator utility is not the solution. The database engine itself, w3dbsmgr.exe, is what requires elevated privileges.
After Installing Pervasive

Common Questions:

This section contains information that you should read after running the installation program. If you are having problems with your installation, go to Troubleshooting After Installation, or get help online from the Knowledge Base at the Pervasive Software website.

What happened to PVSW\BIN on Windows platforms?

Starting with Pervasive PSQL v10, files are no longer installed to <drive>:\pvsw\bin on Windows platforms. This change comes as Pervasive PSQL adapts to suggested guidelines from Microsoft.

Where are the Pervasive PSQL files installed?

Table 3 lists the default locations where Pervasive PSQL installs the program and application data files on Windows platforms.

<table>
<thead>
<tr>
<th>Platform</th>
<th>File Types</th>
<th>Default Installation Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Vista and later¹ (64-bit)</td>
<td>Application Data</td>
<td>&lt;drive&gt;:\ProgramData\Pervasive Software\PSQL\</td>
</tr>
<tr>
<td></td>
<td>Program Files (64-bit)</td>
<td>&lt;drive&gt;:\Program Files\Pervasive Software\PSQL\</td>
</tr>
<tr>
<td></td>
<td>Program Files (32-bit)</td>
<td>&lt;drive&gt;:\Program Files(x86)\Pervasive Software\PSQL\</td>
</tr>
<tr>
<td>Windows pre-Vista² (64-bit)</td>
<td>Application Data</td>
<td>&lt;drive&gt;:\Documents and Settings\All Users\Application Data\Pervasive Software\PSQL\</td>
</tr>
<tr>
<td></td>
<td>Program Files (64-bit)</td>
<td>&lt;drive&gt;:\Program Files\Pervasive Software\PSQL\</td>
</tr>
<tr>
<td></td>
<td>Program Files (32-bit)</td>
<td>&lt;drive&gt;:\Program Files(x86)\Pervasive Software\PSQL\</td>
</tr>
<tr>
<td>Windows Vista and later¹ (32-bit)</td>
<td>Application Data</td>
<td>&lt;drive&gt;:\ProgramData\Pervasive Software\PSQL\</td>
</tr>
<tr>
<td></td>
<td>Program Files</td>
<td>&lt;drive&gt;:\Program Files\Pervasive Software\PSQL\</td>
</tr>
</tbody>
</table>
What is an Application Data file?

Application data files are typically files to which the system can write. Examples of Application Data files include log files, tutorial files, and sample database files, such as DEMODATA and TEMPDB.

What is a Program File?

Program files are typically files the system requires in order to function. Examples of program files include binary system files, executable files, dynamic link libraries and JAR files.

What is the difference between 32-bit and 64-bit Program Files?

Microsoft guidelines recommend that 64-bit components are installed in a separate location to 32-bit components. Pervasive PSQL 64-bit components are installed in the 64-bit program files location and are registered in the Windows registry under the 64-bit hive. 32-bit components are installed in the 32-bit program files location and are registered in the Windows registry under the 32-bit (x86) hive.

Do I need to install the Client with a Workgroup engine?

If you are installing the Workgroup engine, you must have a license for and install the software on every computer that is expected to share data within your workgroup. Because every computer must have the Workgroup engine installed and the client software is installed with every engine by default, there is no need to install the client software separately.

Note: Only the 32-bit Client components are installed.
How Do I Read the Online Documentation?

The viewer for the documentation library is integrated into Pervasive PSQL Control Center (PCC). Access the documentation library through the PCC interface on the Welcome view, in the Help menu, by pressing F1 (Windows).

You can also view the documentation in the form of Adobe Acrobat (PDF) files. These PDF files are available on the Pervasive PSQL installation media in the Books directory.

How Do I Verify or Update My User License?

Licenses from previous versions of Pervasive PSQL are not migrated or transferable to Pervasive PSQL v11 SP1. You must have a license applicable for Pervasive PSQL v11 SP1, unless you choose to install using the trial version of the product.

The License Administrator utility is documented in *Pervasive PSQL User’s Guide* in the section License Administration. Please refer to that document for information on user licenses.

What User License Was Installed with Pervasive PSQL?

A trial license is installed if you leave the license number blank during installation.

There is no configuration necessary for the license. After installation, you can use the License Administrator utility to view your installed licenses. See the *Pervasive PSQL User’s Guide* for more information on the License Administrator utility.

Uninstalling Pervasive:

The uninstall program removes the Pervasive PSQL engine, and all related components from your system that were added by the installation program, including registry settings, configurations and Pervasive PSQL system and sample databases.

The uninstall program does not remove the following:

- Databases that you create under the Pervasive PSQL Server installation directory.
- DSNs and database names associated with those databases.
- Databases in locations other than the Pervasive PSQL Server installation directory.
- DSNs and database names associated with those databases.

To uninstall Pervasive PSQL

1. In the Windows Control Panel, select Add/Remove Programs.

2. Select the installed Pervasive PSQL v11 SP1 product from the list.

3. Click Change then Next.

4. Click Remove then Next and follow any prompts during the uninstall.

If prompted, close or uninstall any running applications that may interfere with uninstalling Pervasive PSQL.

**Caution** Unpredictable results may occur during the uninstall if you ignore programs that may interfere.

Reboot your system, if prompted to do so.
Configuring the Workgroup Engine

Overview:

*Installation Requirements*

Every computer that may be used to access the same data at the same time must have a Workgroup engine installed on it.

*Operating System Security*

Only database server engines can enforce OS level file security based on the privileges assigned to the login user name. The Workgroup engine does not attempt to do this. In a small office, where Workgroup engines are most common, this can be considered a plus because they are usually short on networking experts, and the fewer barriers to successful data access the better.

*When to Use Workgroup*

There are three main configurations in which you would want to use the Workgroup engine.

1. **Small Client/Server Configuration**

   The first configuration takes place when all the data is located on a single computer with a Workgroup engine installed, and there is limited sharing of data. This configuration is roughly equivalent to a small client/server configuration.

2. **Peer-to-Peer Configuration**

   Another situation when you would want to use the Workgroup engine is when the data is distributed among the workstations. This is called a peer-to-peer topology. This configuration is used when each application typically stores much of its own data on the local hard drive, but periodically needs to access data from other workstations or share its own data with others.

   In this configuration, each computer shares its data directory or directories. Any computer that needs access to that data maps one or more drives to the shared data directories. Then the Workgroup engine on each computer acts as a mini-server engine to read/write all changes to the data files on that machine.

3. **Gateway Configuration**

   The third topology requiring the use of the Workgroup engine is when the data is stored on a file server where there is no MicroKernel engine. This can be a UNIX server or other type of
network file server that gets backed up regularly, but cannot support a MicroKernel engine. In this situation, the first Workgroup engine that opens files in a directory on the server becomes the Gateway to each file in that directory. The other workstations access the data in a client-server fashion through that Gateway engine.

The Gateway engine for a given directory identifies itself by creating a file named ~PVSW~.LOC in that directory. This file is called a Gateway locator file and contains the network name of the computer where the Gateway engine is located. Other Workgroup engines attempting to access this data read the locator file to find the name of the engine they must communicate with in order to access the data. You can ensure that the same engine always services the files in a given directory by making the locator file read-only. This is called a static gateway, also referred to as a fixed gateway. See To Set up a Fixed Gateway for more information.

The Gateway engine acts as a server engine as it reads and writes pages to the data files, allowing it to make the most use out of its cache. The Gateway feature is designed so that the ownership of any particular directory can change whenever the current gateway engine has no more client applications with any files open in that directory. When the last data file is closed in a directory by a given database engine, the engine releases and deletes the locator file. When the next engine opens a data file, that engine becomes the new gateway to the directory where the data file(s) resides.

What is a Gateway Engine?

A Gateway engine is a Workgroup engine that acts as the sole point of access to all data files in a particular directory on a remote file server. If several Workgroup engines are accessing the same database at the same time, they do not all open the files simultaneously, nor do they share the files. Rather, the first Workgroup engine to access that database becomes the temporary “owner” of those files, and all other Workgroup engines must access the data by contacting the Gateway engine. Only the Gateway engine has the files open and reads/writes the files. The other Workgroup engines act as clients, making requests to the Gateway engine acting as a mini-server engine.

Caution Make certain the Gateway computer is NOT shut down while users are still using it as a Gateway, or data loss can occur.

Setting Up a Small Client/Server Configuration:
As explained in Small Client/Server Configuration, you should use this set up when you have only a few workstations sharing data located on a central computer where you have a Workgroup engine installed.

If you have data located on many computers, or if you do not or cannot install a database engine on the computer where the data is located, you should use one of the other configurations.
To Set Up a Small Client/Server Configuration

1. You must have the Workgroup engine installed both on the central computer where the data is and on all computers expected to access the data.

Ensure that the Workgroup engine on the central computer where the data is located is operational each time the computer is started, before any other database engines attempt to access the data. If the Workgroup engine was installed as an application, ensure that the application starts if the computer is restarted. A Workgroup engine starts by default if installed as a server. See Running the Workgroup Engine as a Service.

Note
You may inadvertently fall into a Gateway configuration if the database engine on the machine where the data is located is not started when the computer is started. If another Workgroup engine attempts to access the data and the local database engine is not running, the other database engine may establish itself as the Gateway for those data files.

You can resolve this situation by shutting down the computer where the data is located, and starting it again, while ensuring that no other computers request data before the local Workgroup engine is restarted. You may need to remove the file ~PVSW~.LOC from the data directory to ensure the Gateway is not re-established.

The best way to ensure that only the Gateway services the file is to set a static gateway locator file using the Gateway Locator Utility.

2. Share the directory where the data is located so that other computers can map a drive to the data directory.

3. Ensure that each workstation expected to access the data can access the named database on the central computer. See Named Database in Advanced Operations Guide.

Setup is complete. The Workgroup engine on the machine where the data is located now acts as a mini-server, to fulfill all requests for data on that machine.

Setting Up a Peer-to-Peer Configuration:

As explained in Peer-to-Peer Configuration, you should use this set up when you have workstations sharing local data as well as data located on many different machines, and each machine has the Workgroup engine installed.

This configuration is similar to the small client/server configuration discussed above, except that now every Workgroup engine is sharing data as a server.
If you have data located on only one computer, or if you do not or cannot install a database engine on the computer where the data is located, you should use one of the other configurations.

➢ **To Set Up a Peer-to-Peer Configuration**

1. You must have the Workgroup engine installed on each computer where data is located, and installed on all computers expected to access the data.

Ensure that the Workgroup engine on each computer where the data is located is operational each time the computer is started, before any other database engines attempt to access the data. If the Workgroup engine was installed as an application, ensure that the application starts if the computer is restarted. A Workgroup engine starts by default if installed as a service. See [Running the Workgroup Engine as a Service](#).

---

**Note** You may inadvertently fall into a Gateway configuration if the database engine on a machine where data is located is not started when the computer is started. If another Workgroup engine attempts to access the data and the local database engine is not running, the other database engine may establish itself as the Gateway for those data files.

You can resolve this situation by shutting down the computer where the data is located, and starting it up again, while ensuring that no other computers request data before the local Workgroup engine is restarted. You may need to remove the file `~PVSW~.LOC` from the data directory to ensure the Gateway is not re-established.

The best way to ensure that only the Gateway services the file is to set a static gateway locator file using the **Gateway Locator Utility**.

2. On each computer where data is located, share the directory where the data is located so that other computers can map a drive to the data directory.

3. Ensure that each workstation expected to access the data can access the named database to which the data belongs. See [Named Database](#) in *Advanced Operations Guide*.  
   Also, ensure that each Workgroup engine can access any local data from its own physical drive.

4. Set up is complete. The Workgroup engine on each machine where data is located now acts as a mini-server, to fulfill all requests for data on that machine.

Each Workgroup engine also handles any local data access, that is, database requests from applications on that machine for data that resides on the same machine.
Configuring Engine Network Communications

Setting Up TCP/IP Support:

By default, TCP/IP is supported between Pervasive PSQL clients and remote database engines or between multiple Workgroup engines. If you have modified the default settings or need to verify that TCP/IP support is available, refer to this section.

**Note** To perform any of the tasks in this section, you must have full administrator-level rights on the machine where the database engine is running, or be a member of the Pervasive_Admin group defined on the machine where the database engine is running.

➢ To Enable TCP/IP Support

Complete the following steps to ensure that the database engine can communicate with clients over TCP/IP networks.

1. On the Start menu select Control Center (PCC) from the Pervasive PSQL v11 SP1 program group.

2. In the Pervasive PSQL Explorer, double-click Engines to display a list of the engines registered with PCC.

3. Right-click the target engine and click Properties. Login if prompted.

4. Click Communication Protocols, and the list of Supported protocols displays. If the list of Supported protocols shows the value TCP/IP checked, then TCP/IP is already supported.

5. Click TCP/IP then restart the database engine for the changes to take effect.

**Tip** Remember that you also need to confirm that your client computers or the client software on your other Workgroup computers are configured to use TCP/IP, as well. See Configuring Network Communications for Clients.

➢ To Enable Multi-homed TCP/IP Support

Completing the following steps configures your Windows server to use two installed network cards.

1. On the Start menu select Control Center (PCC) from the Pervasive PSQL v11 SP1 program group.
2. In the PCC Pervasive PSQL Explorer, double-click Engines to display the list of registered engines with PCC.
3. Right-click the target engine and click Properties. Login if prompted.

4. Click Communication Protocols and click TCP/IP Multihomed to configure the server engine to listen for client connections on multiple network interfaces.

If you only have one network interface, this setting is ignored.

5. Restart the server engine for the changes to take effect. You do not need to make any changes to client settings.

---

**Setting Up SPX Support:**

SPX is supported between Pervasive PSQL clients and servers. If you have modified the default settings or need to verify that SPX support is available, refer to this section.

Your network’s SPX Frame Type setting does not have any effect on Pervasive PSQL. All computers communicating over SPX should be configured for the same SPX Frame Type. The Ethernet_802.2 frame type is the default and is recommended.

---

**Note** In order to perform any of the tasks in this section, you must be a member of the Pervasive_Admin group defined on the server.

---

➢ **To Enable SPX Support**

Complete the following steps to ensure that the database server engine can communicate with clients over SPX networks.
Note In an all-Microsoft environment, SPX can be used with applications that use only the Pervasive PSQL transactional interface. Applications that use only the transactional interface do not require name resolution with SPX.

1. On the Start menu select Control Center (PCC) from the Pervasive PSQL v11 SP1 program group.

2. In the PCC Pervasive PSQL Explorer, double-click Engines to display a list of the engines registered with PCC.

3. Right-click the target engine then click Properties. Login if prompted.

4. Click Communication Protocols, and the list of Supported protocols displays. If SPX is checked, then SPX is already supported.

5. Click SPX then restart the database engine for the changes to take effect.

Tip Remember that you also need to confirm that your client computers are configured to use SPX, as well. See Configuring Network Communications for Clients.

Setting Up NetBIOS Support (Workgroup only):

By default, NetBIOS is supported among Pervasive PSQL Workgroup engines. If you have modified the default settings or need to verify that NetBIOS support is available, refer to this section.

Note In order to perform any of the tasks in this section, you must be seated at the console of the machine running the Workgroup engine. You cannot remotely configure the Workgroup engine.

➢ To Enable NetBIOS Support

Complete the following steps to ensure that the database engine can communicate with clients over NetBIOS networks.

1. On the Start menu select Control Center (PCC) from the Pervasive PSQL v11 SP1 program group.

2. In the Pervasive PSQL Explorer, double-click Engines to display a list of the engines registered with PCC.

3. Right-click the target engine then click Properties. Login if prompted.
4. Click **Communication Protocols**, and the list of **Supported protocols** displays. If **NetBIOS** is checked, then NetBIOS is already supported.

5. Click **NetBIOS** then restart the database engine for the changes to take effect.

**Tip** Remember that you also need to confirm that the client software on your other Workgroup computers are configured to use NetBIOS, as well. Please refer to [*Configuring Network Communications for Clients*](#).
Avoiding Unavailable Protocols:

It may be possible to improve performance on the initial connection to the database by disabling database communications support for any protocols that are not available on your network or that you do not wish to use.

In order to perform any of the procedures in this section you must have one of the following:

- Full administrator-level rights on the machine where the database engine is running
- Membership in the Pervasive_Admin group defined on the machine where the database engine is running.

Note In order to perform any of the tasks in this section, you must be seated at the console of the machine running the Workgroup engine. You cannot remotely configure the Workgroup engine.

➢ To Remove Support for a Network Protocol

Note This procedure does not affect your operating system configuration in any way. This procedure only prevents the database communications system from attempting communications on unavailable or undesired protocols.

1. On the Start menu select Control Center (PCC) from the Pervasive PSQL v11 SP1 program group.

2. In the PCC Pervasive PSQL Explorer, double-click Engines to display a list of the engines registered with PCC.

3. Right-click the target engine then click Properties. Login if prompted.

4. Click Communication Protocols, and the list of Supported protocols displays. Selected protocols are considered available for use by the engine.

5. Clear the check box for any of the selected protocols that are not supported on your network or that you do not wish to use.

You must leave at least one protocol selected.

6. Click OK then restart the database engine for the changes to take effect.
Tip Remember that you also need to confirm that your client computers are configured to use the protocol remaining in the Supported protocols list. Please refer to Configuring Network Communications for Clients.

Configuring Network Communications for Clients

To access network files from a machine using a Pervasive PSQL application, you must use the appropriate client requester at that machine. Your application’s Pervasive PSQL calls go through the client requester, which sends them to the server for processing and then returns the reply to your application.

Generally, the default configuration settings for Pervasive PSQL Server and Client are sufficient. You typically do not have to configure any settings for the database engine and clients to communicate and function together correctly.

Network Path Formats Supported by Requesters:

This section lists the configuration settings used by the Pervasive PSQL Clients for network communication. These settings may be changed using a command line utility or from within PCC on the engine properties.

The Advanced Operations Guide provides detailed information about each of the settings. See the following configuration settings in Advanced Operations Guide for network communication:

- Enable Auto Reconnect (Windows only)
- Supported Protocols
- Connection Timeout

Network Path Formats Supported by Requesters:

When using your Requester, you connect to the Pervasive server engine to access data files. This section shows the variations on network file syntax you can use to access files on your network using Btrieve or SQL applications.

Pervasive PSQL supports the Universal Naming Convention (UNC) and Drive path formats (explicit and current) across the majority of operating environments. For more information on the path formats, see the sections that follow:

- Universal Naming Convention (UNC) Path Formats
- Drive-based Formats
If you are an application developer, also note that the certain access methods, such as the Btrieve API, support URI connection strings.

For details about URI strings, see Database URIs in Pervasive PSQL Programmer's Guide. In Btrieve API Guide, see Create (14), Open (0), and Login/Logout (78).

**Universal Naming Convention (UNC) Path Formats**

The following UNC path formats are supported on all clients to all servers:

\ServerName or IP address\share\path\file
\ServerName or IP address\share:[\]path\file

UNC syntax is resolved correctly regardless of the actual type of network operating system (NOS) running on the target server. If you use an IP address, it must be a dotted IPv4 address or one of the two formats supported for IPv6. See IPv6 With UNC Paths and URI Connections.

**Note** In all instances above, backslashes (\) can be interchanged with forward slashes (/) except for the double backslash (\\). The syntax [\] indicates that the backslash is optional.

**Drive-based Formats**

The following drive representations are supported on all clients to all servers:

drive:file
drive:[]path\file
file
[]path\file
..\file
Application Configuration Scenarios

Terminal Services:

Microsoft Terminal Services is a multi session environment that provides remote computers access to Windows-based programs running on a server. Citrix MetaFrame extends Windows Terminal Services with additional client and server functionality.

Disabling Administrative Functions

In prior releases, the ability to perform administrative functions was prohibited from the client. In Pervasive PSQL v11 SP1, Pervasive PSQL clients running within Terminal Services client sessions can perform Pervasive PSQL administrative functions by default. For example, a user with such a client can change configuration settings for Pervasive PSQL, create DSNs, and use the Monitor utility.

If you want to restrict this capability, intervention is necessary from a system administrator.

➢ **To disable remote administrative functions for Terminal Services clients**

1. From PCC, open the properties for the MicroKernel Router under Local Client.

See To access configuration settings in PCC for a local client in Advanced Operations Guide.

2. On the Properties dialog, check Restrict Administrative Functions from a WTS Client.

3. Click OK, then exit PCC and start it again for the setting to take effect.

**Note** Pervasive PSQL Server engines are supported for use with Microsoft Terminal Server and Citrix MetaFrame running within an Active Directory environment.

Terminal Server as Network Server

You may use your terminal server as your main network server and database server. However, if you have high usage of the server as a file server as well as many terminal sessions running at the same time, you may find the performance less than satisfactory.

Another concern is having all of your mission critical services on the same machine. If it goes down, all of your services go down at once. For these reasons, you may wish to consider distributing your mission critical services on two or more computers.
Workgroup Engine Running as a Service

You may configure your server to run the Workgroup engine as a service. This allows the engine to start automatically when the operating system starts. A user is not required to log in to start the engine. Refer to Running the Workgroup Engine as a Service.

Caution Running the engine as a service requires the Log On as Service privilege. If you select to run the engine as a service under a user account other than the default Local System account, you will need to modify the Log On Properties for the Service using the Windows Control Panel.

Active Directory Service:

Active Directory is a central component of the network architecture on certain Windows operating systems. Active Directory provides a directory service specifically designed for distributed networking environments.

This section describes how to configure Pervasive PSQL in an environment that has Microsoft Active Directory service installed and functioning correctly.

Ensure that Active Directory service is installed and functioning correctly before you install Pervasive PSQL into the environment.

Server and Client Support

Pervasive PSQL Server runs on supported Windows Servers within an Active Directory environment. The Pervasive PSQL clients run on all supported Windows platforms within an Active Directory environment.

Directory and File Permissions

The database engines enforce directory and file permissions set at the operating system level. An Active Directory environment does not change this behavior. For example, if you set “read only” permission on a Pervasive PSQL table file, you will be unable to write to the table.

Microsoft Terminal Services Support
Pervasive PSQL Server engines are supported for use with Microsoft Terminal Server and Citrix MetaFrame running within an Active Directory environment. For more information about Terminal Services and Citrix MetaFrame, see Terminal Services.

**Pervasive Administrative Authority:**

Active Directory service manages the security of the network. You must grant the correct access authority at the operating system level to users who need Pervasive administrative privileges.

See Active Directory Tasks for the steps to set access authority. Users must have the following authority on the machine running the database engine:

- Log on locally
- Administrator privileges or belong to the Pervasive_Admin group

You may grant the Log on locally authority directly to a user or to the Pervasive_Admin group (and add the user to the group).

You may create the Pervasive_Admin group on the machine running the database engine (the local machine), on the domain controller for the local machine, or on both. The database engine checks privileges first on the domain controller for the local machine then on the local machine.

An example helps illustrate this. Suppose you have two servers in your domain that run the Pervasive PSQL database engine, Server A and Server B. You could create a Pervasive_Admin group on each server and on the domain controller. You then add User 1 to the group on Server A, User 2 to the group on Server B, and User 3 to the group on the domain controller. User 1 has administrative privileges for the database engine only on Server A. Similarly, User 2 has administrative privileges only on Server B. User 3, however, has administrative privileges for the database engines on both Server A and Server B.

If you create the Pervasive_Admin group on a domain controller, then the group must be a domain local group. If you create the Pervasive_Admin group on a machine that is not a domain controller, then the Pervasive_Admin group must be a local group.
Active Directory Tasks:

This section explains the tasks needed to ensure users have Pervasive administrative privileges. The tasks assume the following:

- Network user IDs have been added for users who need Pervasive administrative privileges
- A Pervasive_Admin group has been created on the domain controller and users added to the group
- Windows Server 2003 is the operating system on the domain controller.

➢ To Create the Pervasive_Admin Group on a Domain Controller

1. Click Start → Programs → Administrative Tool → Active Directory Users and Computers.

2. Expand the tree for the domain to which you want to add the Pervasive_Admin group.

For example, the following image shows the expanded tree for the DSTEST.com domain.

3. Right-click the Organizational Unit or folder that you are using in your Active Directory environment to house groups, then click **New** → **Group**. For example, the following image shows an Organizational Unit named “Groups,” but your Organizational Unit may be named differently.
Note If your Active Directory environment does not have an Organizational Unit to house groups, you need to create one. Click the domain root (for example, in the figure above, you would right-click ADSTEST.com), then click Action → New → Organizational Unit. Type a meaningful name for the unit, then click OK.

4. For Group name, type Pervasive_Admin. Click Domain local for group scope.

Note The Pervasive_Admin group must have a scope of Domain local. Do not use Global or Universal.

5. Click OK. Now that the Pervasive_Admin group exists, you need to add users to it.

6. On the Active Directory Users and Computers window, right-click the Pervasive_Admin group, then click Properties. (You may also double-click the group.)
7. Click the **Members** tab on the **Properties** dialog box.

8. Click **Add** on the **Members** tab.

9. Click the user in the **Name** list that you want to add to the Pervasive_Admin group, then click **Add**.

The user is added to the list on the bottom. For example, the following image shows that user ADS_USER1 has been added.
10. Click OK.
The user you added now appears as a member of the Pervasive_Admin group.

<table>
<thead>
<tr>
<th>Pervasive_Admin Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
</tr>
<tr>
<td>---------</td>
</tr>
</tbody>
</table>
| Members:
Name     | Active Directory Folder |
| ADS_User1 | ADSTEST.com/Users |

11. Click OK to exit the properties dialog box.

12. Add the Pervasive_Admin group to the Log on locally privileges (complete the task To Grant Log On Locally Privileges to the Pervasive_Admin Group).

➢ To Grant Log On Locally Privileges to the Pervasive_Admin Group

1. In the Windows Control Panel double-click Administrative Tools, then double-click Domain Controller Security Policy.

2. Expand the following security settings:
   - Security Settings
   - Local Policies
3. Click **User Rights Assignment**.

4. Scroll the policies in the right pane until you locate **Log on locally**.

5. Double-click the **Log on locally** policy (or right-click the policy then click **Security**).

The **Security Policy Setting** dialog box appears.
6. Click **Add**. The **Add user or group** dialog box displays.

7. Type **Pervasive_Admin** in the **Users and group names** field.

You may also specify the group by clicking **Browse** and navigating to the group through dialogs.

8. Click **OK**. The Security Policy Setting dialog appears with Pervasive_Admin added.

9. Click **OK** to exit the Security Policy Setting dialog.


**Concurrent Local and Remote Applications:**

The Server engine allows both remote client requests as well as communications from applications running on the same computer as the server.

**Note** To perform these steps, you must have full administrator level rights on the machine where the database engine is running, or be a member of the Pervasive_Admin group defined on the machine where the database engine is running.

- **To configure database connections from both remote and local applications**

  **Tip** When changing the Server engine settings, you must be at the Windows server computer where the database server runs.

1. Click **Control Center** from the **Pervasive** program on the **Start** menu.
2. In the Pervasive PSQL Explorer, expand Engines to display the engines registered with Pervasive PSQL Control Center.

3. Right-click the target engine and click Properties. Login if prompted.

4. Click Access. In the right-hand pane, select the Accept Remote Requests check box. If you wish to prevent the server from accepting client connections from other computers, clear the check box.

5. Click OK.

This configures the server to accept remote requests.

6. In the Pervasive PSQL Explorer, expand Local Client.

7. Right-click MicroKernel Router and click Properties. Login if prompted.

8. Click Access. In the right-hand pane, select the following checkboxes:
   - Use Local MicroKernel Engine. Select this check box to configure the local engine for local file access.
   - Use Remote MicroKernel Engine. Select this check box to access databases on other computers.

If you plan to only access data on this computer, clear this check box.

9. Click OK.

This configures the server to accept local requests.

10. Restart the server engine to implement the changes.
Using the Server and Workgroup Engines Concurrently:

The Workgroup engine can be configured to access files on a remote file server through a mapped drive on a Windows server.

The client software installed with your Workgroup engine can be used to connect to other server engines on a remote machine.

If you want to use your local engine for local file access and a remote server for access to files being serviced by the remote Pervasive server, you must change the settings in your MicroKernel Router. Use the Pervasive PSQL Control Center to change MicroKernel Router settings.

➢ To configure local and remote access for the MicroKernel Router

1. On the Start menu select Control Center (PCC) from the Pervasive PSQL v11 SP1 program group.

2. In the Pervasive PSQL Explorer window, expand Local Client.

3. Right-click MicroKernel Router and click Properties. Login if prompted.

4. Click Access. In the right-hand pane, select the following check boxes:

   ▪ Use Local MicroKernel Engine. Select this check box to configure the local engine for local file access.

   ▪ Use Remote MicroKernel Engine. Select this check box to configure the remote server for access to files being serviced by the remote Pervasive server.

5. Click OK.

Note See Advanced Operations Guide for more information on changing settings using the Pervasive PSQL Control Center.
Accessing Data on Other Computers:

The Workgroup engine provides great flexibility for a variety of small networked environments. The table below explains the most common configurations and where to look for more information. In any of the configurations below, a Workgroup engine must be installed on every computer that is expected to access data.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Where to look for more information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small client/server: Data resides on a single computer where a Workgroup engine is installed.</td>
<td>Setting Up a Small Client/Server Configuration</td>
</tr>
<tr>
<td>Peer-to-Peer: Data resides on two or more computers where Workgroup engines are installed.</td>
<td>Setting Up a Peer-to-Peer Configuration</td>
</tr>
<tr>
<td>Gateway: Data resides on a file server where no database engine is installed, or it is not running.</td>
<td>Setting Up a Gateway Configuration</td>
</tr>
</tbody>
</table>
Troubleshooting after Installation

*How to Proceed When You Encounter Errors During Installation*

Pervasive Software provides several features and tools in Pervasive PSQL v11 SP1 that help to prevent configuration and installation problems.

Some of these utilities are installed and run as part of the installation process and all can be run later to evaluate configuration and registry settings and to troubleshoot problems. They are shown in Table 18.

**Troubleshooting Tools:**

The following table describes some tools that can help you avoid or solve problems.

<table>
<thead>
<tr>
<th>Feature/Component</th>
<th>Function</th>
<th>For More Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pervasive System Analyzer</td>
<td>Analyzes system components and runs communication tests.</td>
<td>See Diagnosing Problems with Pervasive System Analyzer (PSA).</td>
</tr>
<tr>
<td>Pervasive Message Logging</td>
<td>Logged messages can be of type status, information, warning, or error, and can originate from any Pervasive PSQL component.</td>
<td>See Pervasive PSQL Message Logging</td>
</tr>
<tr>
<td>Gateway Locator</td>
<td>Determines or changes the Gateway being used for a particular data dictionary (only in Pervasive PSQL v11 SP1 Workgroup Edition.)</td>
<td>See Configuring the Workgroup Engine.</td>
</tr>
<tr>
<td>Knowledge Base</td>
<td>Provides information about many Pervasive software configurations and common environments.</td>
<td>Search the Pervasive Knowledge Base at: <a href="http://www.pervasivedb.com">www.pervasivedb.com</a></td>
</tr>
</tbody>
</table>

**Troubleshooting Strategies:**
Pervasive Software hopes that your installation process completes without experiencing any problems. However, this depends on a number of factors, including proper network support, and operating system configuration.

If something does go wrong during an installation, Pervasive offers some tools that can help in diagnosing the problem. This section explores some of the troubleshooting techniques that you can use.

**Note** If the installation fails for any reason, the installation log file can be found in the Windows %Temp% directory.

**Checklist for Problems**

- Did you see any error messages displayed during installation?
- Does the Network function correctly?
- Do you have the appropriate administrator-level privileges?
- Is the Engine running?
- Is the Client software correctly functioning?
- Are there errors in your PVSW.LOG file?

**Configuration for Special Installation Situations:**

This section lists some scenarios where the *default* configuration settings for Pervasive PSQL need adjusting for proper database operation.

The following table summarizes some of these situations. If you find that your configuration matches an issue, please see the reference included for more information.
<table>
<thead>
<tr>
<th>If your computing environment includes...</th>
<th>Then you need to:</th>
</tr>
</thead>
</table>
| Microsoft Active Directory Service       | Read the following section:  
  * [Active Directory Service](#)  |
| Multiple network interfaces             | Enable a configuration setting for Multi-homed setting  
  In [Advanced Operations Guide](#), see:  
  * [TCP/IP Multihomed](#)  
  * [Listen IP Address](#)  |
| A network that is subject to outages     | Enable a configuration setting that tries to auto-reconnect to a server when a network outage occurs  
  In [Advanced Operations Guide](#), see [Pervasive Auto-Reconnect](#)  |
| Database filenames that must not include embedded spaces | Enable a configuration setting that instructs Pervasive PSQL to reject files with embedded spaces in the name.  
  In [Advanced Operations Guide](#), see [Embedded Spaces and Long File Names and Embedded Spaces Support](#)  |
Diagnosing Problems with Pervasive System Analyzer (PSA):

Pervasive System Analyzer is a diagnostic utility included with Pervasive PSQL v11 SP1.

Pervasive System Analyzer (PSA) is conveniently integrated into the product installation and available as a stand-alone diagnostic tool to help you with the following tasks:

- Troubleshoot network problems
- Detect previous installations of Btrieve or Pervasive PSQL on your system
- Note other factors that influence your networking environment
- View current component set and versions

PSA replaces the features that were previously offered by SmartScout and InstallScout.

**Note** For detailed information on using Pervasive System Analyzer, refer to the *Pervasive PSQL User's Guide*.

Verifying Database Engine is Running:

To verify that the Pervasive PSQL engine is running, see the procedure for your platform and engine:

- Windows Server (Non-Vista)
- Windows Workgroup

*Windows Server (Non-Vista)*

You can use the Services function of the Windows control panel.

➢ **To check Pervasive Services on Windows servers using the Control Panel**

1. At the operating system, open Services under Administrative Tools.

2. Scroll the list of services until you reach the following services.

   - Pervasive PSQL Transactional Engine
   - Pervasive PSQL Relational Engine

Both of these services must be started if Pervasive PSQL is to function correctly. The Status column displays whether or not the service is currently running. The Startup column indicates whether the service is set to automatically start on system startup or start manually.
3. If a service is not started, right-click the service name, then click Start. 

**Windows Workgroup**

To verify that the Pervasive PSQL v11 SP1 workgroup engine is running:

➢ **To start the Pervasive Workgroup engine**

1. From the Start menu, select Engines from the Pervasive program.

2. Click Start Workgroup Engine.

By default, the MicroKernel allocates resources and is ready to service local application database requests.

➢ **To stop the Pervasive Workgroup engine**

1. From the Start menu, select Engines from the Pervasive program.

2. Click Stop Workgroup Engine.

**Note** You will receive a warning message when trying to stop the engine if any of the following is true:

- There are active clients.
- No activity took place since the engine loaded.
- 10 seconds has not elapsed since the last operation took place.
Obtaining File, Client, and Engine Version Number:

You can use Pervasive PSQL utilities to verify that the client and engines have the version number you expect, or to check the version of a particular file.

**Determining Client and Engine Version**

You can check the engine and client versions using Function Executor on Windows platforms or using the BUTIL command-line utility on all platforms. Function Executor is a utility that simulates Btrieve client operations using the Pervasive PSQL requesters.

**Using Function Executor**

Use Function Executor to determine the version of the client, local and remote engines.

➢ To Determine the Engine Version using Function Executor

1. On the Start menu select **Function Executor** from the **Pervasive PSQL v11 SP1 Utilities** program group.

2. Do one of the following:
   a. Click **View □ Version** from the **File** menu.
   b. Select the **Btrieve Version Info** toolbar button, as shown in Figure 8.

   *Figure 8  Selecting the Btrieve Version Info button*

3. After choosing either of the **Version** options, a dialog box displays that indicates the version of the client requesters and the local engine. If a file is open when the Version option is selected, the remote engine version displays as well.
Using the BUTIL Utility

From a command prompt, enter the following:
BUTIL –VER

The requester and engine versions are then displayed. You cannot determine the version of a remote server engine with this tool.

Determining a File Version

You can determine the file version of a MicroKernel data file using the Pervasive PSQL v11 SP1 utilities. On the Windows platform, use Control Center, Function Executor, DDF Builder, or Btrieve Maintenance. On any platform, use the BUTIL command-line utility. The following provides information on using a few of these methods.

Using the Pervasive PSQL Control Center

You can use the Pervasive PSQL Control Center to determine a file version.

➢ To Determine the File Version of a Table Using Pervasive PSQL Control Center

1. On the Start menu select Control Center (PCC) from the Pervasive PSQL v11 SP1 program group.

2. Find the database by expanding its name in the Pervasive PSQL Explorer on the left.

3. Do one of the following:

   a. Click File ➔ Properties from the File menu.
   b. Right-click a table name and select Properties as shown in Figure 10.
4. The table properties are displayed, which includes the file version of the underlying MicroKernel data file version.

**Figure 11  Table Properties Page**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table Name</td>
<td>Billing</td>
</tr>
<tr>
<td>Table Location</td>
<td>C:\DOCUMENTS AND SETTINGS\ALL USE\</td>
</tr>
<tr>
<td>Dictionary Path</td>
<td>C:\DOCUMENTS AND SETTINGS\ALL USE\</td>
</tr>
<tr>
<td><strong>File Version</strong></td>
<td>9.5</td>
</tr>
<tr>
<td>Record Length</td>
<td>139</td>
</tr>
<tr>
<td>Page Size</td>
<td>4096</td>
</tr>
<tr>
<td>Number of Records</td>
<td>1315</td>
</tr>
<tr>
<td>Number of Indexes</td>
<td>1</td>
</tr>
<tr>
<td>Number of Unused Linked Duplicate Pointers</td>
<td>0</td>
</tr>
<tr>
<td>Number of Unused Preallocated Pages</td>
<td>0</td>
</tr>
<tr>
<td>Variable Length Records</td>
<td>Nc</td>
</tr>
<tr>
<td>Blank Truncation</td>
<td>Nc</td>
</tr>
<tr>
<td>Record Compression</td>
<td>Nc</td>
</tr>
<tr>
<td>Page Compression</td>
<td>Nc</td>
</tr>
<tr>
<td>Key Only File</td>
<td>Nc</td>
</tr>
<tr>
<td>Index Balancing</td>
<td>Nc</td>
</tr>
<tr>
<td>Freespace Threshold</td>
<td>0%</td>
</tr>
<tr>
<td>Uses Alternate Collating Sequence</td>
<td>Nc</td>
</tr>
<tr>
<td>System Data</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Using Btrieve Maintenance

If you are unfamiliar with the command line, you can use the GUIbased Btrieve Maintenance tool.

➢ To Determine the File Version of a Table Using Btrieve Maintenance Utility

1. From the Start menu click Maintenance from the Pervasive Utilities program group.

2. From the File menu, click Options and select Show Information Editor. The File Information Editor dialog box displays.

3. Click Load Information and the Select File dialog box displays.

4. Enter or browse for the file for which you need to determine the version. The version displays in the upper right-hand corner of the dialog box.

Using Function Executor

The Function Executor utility can simulate Btrieve operations and can be used to determine the file version by performing a statistics report against the file.

➢ To Determine the File Version of a Table Using Function Executor

1. From the Start menu click Function Executor from the Pervasive Utilities program group.

2. From the File menu, click File → Open. The Open Btrieve File dialog box displays.

3. Enter or browse for the file for which you need to determine the version.

4. With the file open in Function Executor, click View → File Statistics. The File Statistics dialog box displays the file version in the top portion of the screen, as seen in Figure 12.
Engine and Client Version Conflicts

If you update your engine to the latest Pervasive PSQL version without also updating your client requesters, you may encounter warning messages from Pervasive PSQL indicating the version conflict. The message displayed is:

An engine to client component mismatch was found

When you receive such a message, it is also logged to your Pervasive Event Log (PVSW.LOG).

This message is a warning. The client is not prevented from connecting to the engine in this situation. Note, however, that Pervasive recommends that you use client requesters that are the same version as the database engine. If you choose, you may use a client requester that is an older version than the database engine with which it interacts. In some situations, depending on the type of SDK access method used by your application, an older version requester will not work with the database engine. Your application will be unable to communicate with the database engine. For those situations, you must use client requesters that are the same version as the database engine.

Client requesters that are a newer version than the database engine may or may not function correctly. Pervasive does not guarantee that newer versions of client requesters will function
correctly with older versions of the engine. Therefore, Pervasive recommends that you avoid the use of newer version client requesters with an older engine. If circumstances in your organization dictate that you cannot upgrade the clients for some time, you may want to disable the dialog boxes that appear when your client components are authorized.

However, you cannot disable the entries in the Pervasive Event Log, and you should note that over time this log could grow to a large size as these entries are logged.

To permanently solve the problem, update your client requesters to the same version as your server engine.

Troubleshooting Common Pervasive PSQL Issues

This section outlines problems you may encounter during the installation or when first using the Workgroup product.

**I receive Status 7224 or my license is no longer listed in the License Administrator utility.**

When the Pervasive PSQL Workgroup is installed as an application on Vista and Windows 7 operating systems, you may experience this situation. Applications do not inherit the user’s administrative rights on Vista and Windows 7.

The Workgroup Engine can be installed as a service or you may stop the engine, run it as administrator, and then run the command line license administrator or GUI License Administrator as administrator to apply the license.

**I fail to see the effects of my configuration changes.**

Try stopping and then restarting the database engine. Whenever you make a change to engine configuration components, you must stop and restart the database engine for the changes to take effect. For information on how to start and stop the database engine, see *Verifying Database Engine is Running*.

**Why do I receive Status 7012 when trying to create a new database with the Workgroup Engine using PCC on Windows Vista?**

When PCC creates a new database, the new database name is added to dbnames.cfg and an entry is added to the ODBC.INI registry in order to create a corresponding System DSN.
Due to Microsoft Vista operating system constraints on registry access, the Workgroup Engine should be run in an elevated mode, so that the database System DSN can be created.

Once the System DSN is created successfully, any user may start the Workgroup Engine and use the DSN.

**Note** In Windows Vista, standard users may create *User DSNs* without this restriction.

**Why do I (now) receive Status 95, after running my application successfully?**

Your application has lost its session with the database engine. This can happen if you make changes to your configuration settings and must restart the database engine, as in the troubleshooting example given above. At the moment the database engine is stopped, any application that is running loses its session with the database engine. You must stop all those utilities and restart them in order to reestablish communication.

See the *Status Codes and Messages* manual for more cases in which this status code can be returned.

**Installing a Pervasive PSQL application has rendered another application unusable.**

If the latest DLLs have been overwritten, it is possible to restore the overwritten DLLs using a backup directory that is automatically created when you install Pervasive PSQL v11 SP1.

**How do I verify that my DOS components are functioning properly?**

Pervasive provides a DOS version of BUTIL.EXE for purposes of verifying that your DOS components are functioning properly. This file is installed in the PSQL\BIN folder of the Pervasive PSQL v11 SP1 Program Files default installation directory.

**Why can’t I restart my application after an improper program exit?**

Database engine components may remain in memory if the engine is interrupted improperly.

- **If you cannot restart your program after improperly aborting the application by using Ctrl-C or stopping the process:**
  1. Shut down and restart your system.
  2. Avoid terminating applications in an abnormal manner.
Why isn’t my application using the Workgroup engine?

If you previously installed Pervasive PSQL requesters and later installed the Pervasive PSQL v11 SP1 Workgroup engine but your application is only using the requesters, you may have an outdated configuration that sets Local Access to Off. The Pervasive PSQL v11 SP1 Workgroup engine’s installation does not overwrite existing settings. To reset Local Access to On, see Using the Server and Workgroup Engines Concurrently.

How Do I Access the Pervasive PSQL v11 SP1 Online Manuals?

To access the online documentation:

1. Click Control Center & Documentation from the Pervasive program group off the Start menu.

2. Click the desired manual on the PCC Welcome page. (If the Welcome page has been closed, click Help then Welcome.)

I received an error message during installation that begins: “Setup did not update the PATH statement in autoexec.bat because the new path would be too long for Windows.”

This message appears when the installation program cannot update the PATH environment variable because the resulting PATH definition would be too long (exceeds the environment space). For info on how to increase the environment space defined in config.sys, see the Microsoft knowledge base article:

http://support.microsoft.com/?kbid=230205

If you get this error message, then a REM statement (a comment) has been added to your autoexec.bat file. The REM statement contains the PATH value that would have been entered. You can change the PATH statement manually.

The best approach, if possible, is to install the product at a location with a shorter installation directory so that the value of PATH does not exceed the environment space.

Issues After Uninstalling Pervasive PSQl on Windows

When you uninstall Pervasive PSQl using the Add/Remove Programs mechanism in Windows, you should not have any database engine files remaining on your system. However, some actions such as installing multiple times to the same machine or restoring archived
components can cause a significant number of files to be left on your system. This is a side effect of how the installation process works with the Windows operating system.

In the situations described previously, the files are left because Windows has the files marked with usage counts that indicate that they are being used by more than one program, and therefore the uninstallation program does not remove them from your system.

This is expected behavior, but it may lead you to conclude that the Pervasive PSQL uninstall program is not functioning correctly.
Reference

Server vs. Workgroup Features
Engine Feature Comparison

All Pervasive database engines offer the same powerful feature set and full-functioned support for programming interfaces. The chart below shows the major differences between the different editions of the product.

Table 1-1  Comparison of Server and Workgroup Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Server</th>
<th>Workgroup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supports Btrieve, ODBC, OLE DB, Java, JDBC, PDAC and ActiveX interfaces</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Full-featured relational support (online backup, security, referential integrity, management tools, and so on)</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Binary compatible data files across all platforms and engine editions</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Easy plug and play upgrading, no application changes required to change engines.</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Includes complete online documentation</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Can access data on a file server where no database engine is installed</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Supports remote ODBC client connections</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Requires a Workgroup engine on all computers expected to access remote data</td>
<td>N/A</td>
<td>✔</td>
</tr>
<tr>
<td>Engine runs on Windows</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Engine runs on Linux</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Multi-user for small groups</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Scales to thousands of users</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Extranet license available</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Enforces Operating System Security</td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>

Pervasive PSQL Base Components

For more information on the listed components, please refer to the Getting Started Guide PDF installed with Pervasive v11.
Server Engine (64-bit)
- 64-bit MicroKernel Database Engine (MKDE)
- 64-bit Relational Database Engine (SRDE)
- 32-bit and 64-bit Client Requesters
- Pervasive Distributed Tuning Interface (DTI)

Server Engine (32-bit)
- 32-bit MicroKernel Database Engine (MKDE)
- 32-bit Relational Database Engine (SRDE)
- 32-bit Client Requesters
- Pervasive Distributed Tuning Interface (DTI)

Client (32-bit)
- 32-bit Client Requesters
- Pervasive Distributed Tuning Interface (DTI)
- Pervasive v11 Cache Engine

Workgroup Engine (32-bit)
- 32-bit MicroKernel Database Engine (MKDE)
- 32-bit Relational Database Engine (SRDE)
- 32-bit Client Requesters
- Pervasive Distributed Tuning Interface (DTI)